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Purpose: Todescribeand Document Client Virtual Private Network (VPN) within Checkpoint
Version 3.0 Firewall-1 and SecuRemoteversion 3.0

The Goal of using SecuRemoteisto encrypt datafrom the PC to the Firewall. This can be useful to provide
privacy of data over apublic network. Thistechnology isalso called aVirtual Private Network (VPN). This
paper will describe how a SecuRemote user will retrieve their Email over the Internet.
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Figure 1. SecuRemote with Valid Internet Addresses

Their are three methods to accomplish thistask. Thefirst method isto useaValid Internet IP Address
scheme as shown above. This means the the SecuRemote Client aswell asthe Mail Server have valid IP
Addresses on the Internet.



The Second Method isto use Address Translation on the Firewall, in addition to SecuRemote to gain
accessto the Internal Host as shown in Figure 2. In this method, all internal hosts that need to be accessed
from the Internet must have a corresponding Valid Internet |P Address to make a connection. So if your
employees needed to connect to 50 Internal Hosts (Mail, FTP, Telnet, Web, etc.) , you would need 50 Valid
Internet |P Addresses.
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Figure 2 - SecuRemote with Invalid IP Addresses and Address Translation

Thethird method isto encrypt and “ encapsulate” the data from the PC to the Firewall, and then Route the
packet to the host on the internal network. This meansthat you do not need to have aValid Internet
Addressfor the Internal Host, because the SecuRemote Client only talksto the Firewall. This method could

also be called “encapsulation”, “tunneling”, or “deferred-routing”, because the actual routing to the
destination takes place after the firewall decrypts the packet. Thisis shown below in Figure 3:
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Figure 3. Encapsulation with SecuRemote to Invalid Internet Address

This encapsulation technique allows connectivity from the Internet to Invalid I P Addresses, without having
to publish valid Internet Addresses for every machine that is required remote access.

Configuration

There will be three steps needed to load and configure SecuRemote.
[1]
Client Encrypt

2. Load andinstall the SecuRemote software on the Client PC (See Page 11)

1. Configurearuleonthe Firewall that allowsfor the
(See Page 4)

inthe Action field.

|

3. Configure the SecuRemote Software by double clicking on the envelope *= , in the bottom right hand
corner of the screen, and adding the appropriate Certificate Authority (CA) site. Thiswill be where the
Management Station of the firewall will reside. Most timesthisisthe firewall itself. (See Page 12)




Client Encrypt .
on the Firewall.

Step 1. Configure aRulefor ﬁ‘
Launch the Security Policy Editor asfollows:

Start> Program - Firewall-1 = Security Policy

After the Security policy has been loaded you will need to create the following items:
Network Object defining the Encryption Domain

Firewall Object

Users to Authenticate the SecuRemote Session
A Rulethat Allows SecuRemote

EC AN

This Security Policy will be based on the Diagram in Figure 1 to allow the SecuRemote Client on the Internet
(any 1P Address) to access the SQL-Server at 192.32.32.20.

From the Security Policy, create the encryption domain of 192.32.32.20 using the Network Object Manager as
follows.
Manage 2 Network Objects

Now Select New = Network

Network Objects
~Existing Objects: Now add “encypt-net”
. IP Address 192.32.32.0
Shaw: [Al |
Subnet Mask 255.255.255.0
Click “OK”
Metwork Properties

General I Address Translation I

Marme: Iencr_l,lpt-net

IP Address: [192.32.32.0

Met Mask: |255.255.255.0]

Cormment: i Color: ! | ] :J
Location: — Broadcast: —
’75' Intermal € External [F Allowed T Dizallowed

Ok, I Cancel I Help

The Encryption Domain is used by the Firewall to define those addresses which will be encrypted/decrypted
by the SecuRemote Client. It isnecessary to define this object first, because the definition of the Firewall
Object Definition will use the Encryption Domain Information.



Metwork Objects

- Existing Objects:
Next Define the Firewall object asfollows: Show 21 ]

Select New > Workstation =

Add theFirewall Name:  firew
IP Address: 192.32.42.31

Note:  Usethe Get Address button to fill inthe IP Address. If
this doesn't fill in the | P address make sure the name
“firew” isthe official host name of the computer by
typing in “hostname”. If thisisthe official host name,
make surethat its P Addressisin the /etc/hosts file for
unix machines, or the \winnt\sy stem32\drivers\etc\hosts
filefor NT machines (createthisascii fileif needed).

Make sure that the following options are Workstation Properties
selected from the “ General” Tab on the General ; Interfaces ; Authentication ; Encryption i Address Translation ;
right: .
Mame: ;flrew

- Type Gateway IP Address: |192.52.42.31 Get address !
- Firewall-1 Installed Commert: |
- Exportable ~ Location; —————————

' £ Internal " External ' Beier i L :iv
The“ Gateway” option tells Firewdl-1 there - Tope W e S
is more than one physical Interface. |£ Host @ Gateway | [ Eyparable

. . . . [ ok ] Cancel Hel

The Firewall-1 Installed identifies this ancel | 2P

machine as a Check Point Firewall.

Exportable option allows the “encryption-domain” information to be “exported” to the SecuRemote Clients.
Thisisavery important option, and if not selected, SecuRemote will not work correctly at the SecuRemote
Client. The symptomswill be that the SecuRemote client does not pop-up the Username, and Password
Dialog box, when sending data to anywhere within the encryption domain (192.32.32.0).

VTR ——— Ngxt, Sele(?t the > “Encryption” Tab within the
“firew” object.
General ; Interfaces ; Authentication ;
SHMP Encryptian ; Address Translation . . .
Select the following under the Encryption Domain:
r~ Encryption Domain: 1| — Encryption kethods Defined: —
" Disabled [ C=1 Manual PSEC - Other, and then select 2" encrypt-net” by

IFSEL

= Walid Addreszes
& Other:

l %‘ encrypt-net - 1

I Use Encapsulation

clicking on the arrow to the right of the blank
space under “other”.

Thistellsthe firewall that everything to this
network, the “encrypt-net” will be Decrypted from
the SecuRemote Client. Also, everything that is
sent to the SecuRemote Client, will be Encrypted.

0k ] Cancel i Help ]

For purposes of this configuration, do not select
the Encapsulation option. The “Use Encapsulation” box will be used when we configure SecuRemote for
Figure 3 (page 3) which isthe encapsulation mode. This option allows the SecuRemote Client to “ Tunnel”
or “Encapsulate” the encrypted session to the firewall.

Next Click on 2> “FWZ" asthe encryption method and Select > “EDIT”



FPwZ Properties
L& Key | DH Key]
% FPemote I -ri Generate i
Key|D: d163041a1e409be9del B2cE7
Drate: on Mar 10 16:52:13 1997
Exponent  |053f3c2a27 a73206f9e3 db33d75623 Selfl ch54d
8bE8EC3fb3 2b25dfdddd fff4c172de BfafF02704
feeceacd] ¢ 144f7aB8597 B591 a0d580 0e98=23823
1852474564
Modulus: |0bfd925599 c9ceciads? e387a77elf 523520643
Efcd7072dd dafbdaldbb cefaB0b183 o9 debe2f
1edbB4bef2 Sic3733bef cad3ad1 6 c96eb100fb
3800213659 f
0K i Cancel 1 Help i
FWZ Properties

ChKey DHKey |

92647 2fcc 7
Wwied Oct 22 11:50:07 1937

Fey Id:
Diate:

Key: [631e 8705 b325 Sacd 26d2 26f3 345 ef34 blcl &1 ad
a627 bbcB d137 B1ba cfcl a8k c4ab a6f2 30b4 a9fd
d52f EEc1 Bb15 bfa7 7deb 8d76 5145 cled 1hfe b820

f3bF 4433

Ok Cancel Help

Select the > “CA TAB” and select > “LOCAL” . This
is defining a Certificate Authority (someone who will
validate the authenticity of the keysthat will be
generated on the Firewall.) This CA function is handled
by the Management Server function, which islocated as
adaemon process on the Firewall in our design. Thisis
why you select local.

Next Click on the 2 “ Generate” function which should

ill in something similar to the diagram on the left.

Next, Select the > “DH Key” Tab. Thisiswherethe
Diffie-Hellman key will be generate. Thisisused to
“Exchange Keys” with the SecuRemote Client.

Select 2 “Generate’

Thiswill Generate and store the Diffie-Hellman Key on
the Management Station, and download this
information to the Firewall Module(s) when using a
Management Server that is De-Coupled from the
Firewall Module, the CA will still be defined aslocal.

—— Gui Client Process

A

«— Firewall Module Process

1

In our configuration, all three processes
reside on the same physical machine.

«— Management Server Process

The Diagram on the left shows the different
functional elementsto the firewall system.

In our example, all three processes reside on the
same machine.

Click > “OK” when the DH Key has been
generated.

Next Click onthe 2 “Interfaces’ Tab of the
Firewall Network Object.

Workstation Properties

SHMP I Encryption ! Addresz Translation I

General Interfaces I Authentication

Mame | Address | Metwark Mazk |
le2 10.10.1.2 255.255.255.0
lel 1923232341 255.255.255.0
lel 192324241 255.255.255.0

add. | Edi. | Bencee | [ESHMEGEL
Ok, I Cancel I Help |

Click onthe“SNMP Get” function to retrieve the
Interface Definitions. Thiswill tell the Firewall
Software to Inspect Packets on all of the Physical
Interfacesin the Firewall.

If the SNMP Get function failsonan NT
System, make sure you have loaded the
optional SNMP module fromthe NT
CDROM.

Note:

It isvery important that the Interface Definitions be
filled out correctly so that the Software will be able
to inspect the packets properly on all Interfaces.

Click > “OK” to complete the definition of the Firewall Object.
Click > “Close” to end the Network Objects portion of the configuration.



Define the SecuRemote User in the User Section of the Security
Policy. To accomplish this, select the following from the Main

Security Policy window:

Manage 2> Users

Add aNew User to the system by typing the following:

New -2 Default

Thiswill be the name of the user and the password information that
is used for the SecuRemote Screen that pops up on the SecuRemote

Client machine.

Firewall-1 SecuRemote: Pazsword

|192_32.42.31 %

Site:
User I Ok I
Pagsword: I ﬂl

Add the User asFollows:

Enter the User Name “ Joe”
Validate the Expiration Date Information
31-Dec-1997

Now Select what Method to Authenticate the User
“Joe”, by Clicking

- “Authentication” TAB

Y ou can select from the following in version 3.0B:

[

Firgiafall-1 Pagsswiord

dhdefined
Sikey

I:IS 0
RaDIJs
AgzzureM et Pathwwans Defender

JESWOT

For our purposes we will select the “Firewall-1”
password. Typein apassword withupto 8
characters.

% securemote - Firewall-1 Security Policy

Metwork Objects...
Services...
Besources...
Servers

Time..

Users

File Edit View [ Policy window Help

E2e

r—User

Showy: iAII j

@ Defautt

Edit...
Group.. D
Template... atall . | Help I
_
User Properties
General I Gmupsl Authenticationi Locationl Time I EnCl}lptiDn!
I arne: iiUe
LComment: IS ecuRemote Lseq
Expiration D ate [dd-rmm-pw]: |3‘I -dec-1997
[1]8 I Cancel I Help I
User Properties

Generall Groups  Authentication ILocationI Time I Enc:l_l,lptionl

Authentication Scheme: [{EEENE R

B Settings:

Password [up to 8 characters]:

o]

Cancel Help




Next, select the > “Encryption” Tab
and select the Method of encryption. In our Case,
thiswill be“DES’.

DES
FiE1

Clear

Any

User Properties

General I Gmupsl Authenticationi Locationl Time Eneryption I
— Client Enciyption Settings:
Session Key Enciyption Method:  |DES =
D ata Encryption bethod: hl
Data Integnty Method: 7
IV  Mone & MD5 |
— S uccessrul Authentication T [ack:
| ' None " Log i Alert }
Pazzword expires after IBD _,::' minutes
ak I Cancel I Help |

*kkkkkkkkk Joe’SNOTE********

To Find out what Encryption Typethe
SecuRemote Client is capable of,

select Help = “About Firwall-1 SecuRemote”
On the SecuRemote Client.

About Firewall-1 5ecuRemote

For our SecuRemote Client, It hasthe
“DES” version of encryption as shown to
theright.

This must match the “Encryption” settings
defined in the User Profile Definition on the

&l Sites - FireWall-1 SecuRemote

File  “iew Sites

g7 %

Pazsword: WalE

Help Topics

PS[=] E3

W W

CheckPaint Firetfall-1 Seculemate v
DES [Fw-DES] Werzion 3.0 RC3

Copyright 2 1337 CheckPoint Software Technologies

About FirgWwiall-1 Se

L

firewall as Shown Above.......

Now we must create a group for the User “ Joe”
tobelongto. Select

New = Group and type in“allowed-users”
Select “Joe” and “add” him to this Group.

Click > OK

Group Properties
ame: W
Comment: ;
Color: 1 | ] vi
Mat in Group: In Group:
!3 joe

< Bemove i

Ok Cancel Help




Thiswill complete the User Definitions at the firewall,
and the screen should look like the diagram on the right.

Click“ Close” at this point.

Now we must add the rule that will define Where the
SecuRemote clients are allowed accessto. From the

Security Policy Editor,
Select Edit > Add Rule> Bottom.

As shown below.

% securemote - FireWall-1 Security Polic

File‘u‘iew Manage F‘nlicy Window

g IEEICI T

Delele Hule [el L:n

Sour ce Destination

Users

—Uszers
Shiowr i.&ll j
@ Default
E}' joe
Hew... | Bemove | Edit... |

Inztall... | Help |

Next, change rule 1 in the Security Policy shown below from:

Service Action

|_ any any any drop
Lifter
Cut Ctrl+ "
C CHE e To
N =Ry M Sour ce Destination Service Action
Fiaste Track
e al | owed-users@ny encrypt-net anyClient-Encrypt

% securemote - FireWall-1 Secuiity Policy
Window Help

File Edit View Manage Policy

| ong

e E R E R

PIEETEAR

Secunty Folicy | Address Translation |

Source ‘Des’rina’rion‘ Service ‘ Action ‘ Track

To acconplish this, click
with your right mouse
buttom in the Source
Field Column, to> “Add
User Access’

i@ Any ‘@ Any ‘@ Ay "i drop ‘
| i
( | M
For Help, press F1 [1e2324231 [Peadfwie | [NUM[
Userpccess 3|
— U=zer Group:
@ Al U=ers
@ allowed-users

[0Elete

Now Select 2> “Allowed-User s’
Select “OK”

In the Destination Field Select
“add-> encrypt-net” and Select > “OK”

Allow all services, and select
- “client-encryption” in the Action Field.

Select > “Long-Log” inthe Track Field

Edit |

— Location:
Mo restriction

= Bestrict o I

Ediit |

o ]

Cancel I

Help I




Y ou rule should now look like the following Diagram:

% securemote - FireWall-1 Security Policy

File Edt Yiew Manage Policy “Window Help

2Rz %22 22e @ BlEEER] & 2

Security Palicy i Address Translation I

m Source

| ]
-i @ allovwed-users@any ! %‘ encrypt-net |@ Ay
I |
1] | i

For Help, press F1 {19232 42 31 [Readfwfite | [MLIM | 5

Destina’rion! Service E Action

Thiswill alow all the SecuRemote Users defined in “ Allowed-users” to access any device on the “encrypt-
net” using any services (ie. Telnet, FTP, Mail, HTTP, etc.).

The Track Column will alow the Logging of the Authentication of the SecuRemote User aswell asthe
Connection information.

Now we must Install the Security Policy on the Inztall Security Policy Module ’
firewall. To Perform this action — Install Security Policy on:
Select Policy 2> Ingtall I ] firew
The Screen to the Right will Show up with the
Firewall Object “Firew” in the window.
If there is no object in thiswindow, you have not
defined the “Firew” object correctly (you need to
make sure Firewall-1 Installed is selected inthe
object definition). Clear | Al | i
Click > OK
0k, I Cancel | Help |
To Install this policy on the firewall

This Screen should show up as | MRSl itz
the Secul’lty Poli cy issaved in securemaote. W Security Palicy Script generated inta securemate. pf _-:j
. . [{=
Inspect Script, and Compiled Compied OK.
into machine language codeto Inztalling Security Policy securemote on all. alléztrek
be downloaded to the Firwall Inztalling Security Policy on localhostfirew)] succeeded
T i Done.
Module. Thisisfunctionally
what is happening here.
If you see §ucgeeded , then the < LI_I
security Policy is successful.
Now onto the SecuRemote
Client.......
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Step 2. Load and Install the Software on the SecuRemote Client

In order to load the software on the Client PC, simply execute the “ setup.exe” file on the SecuRemote Floppy

Disk or wherever the software has been downloaded to on the Hard Disk. In our case, the software has
been |oaded on the hard disk under the C:\temp\securemote subdirectory. Simply typein “setup” at this

point from the C:\temp\securemote directory. Thiswill step you through avery simple installation process.

*kkkkkkhkkx NOTE *kkhkkkkkhkkhkkkx

The most important part of the Software Network 2]

installation isto know what LAN Adapter, or
DIAL-UP Adapters will be used for SecuRemote
Encryption. SecuRemote will provide you with the
option of using either both the Dial-up and LAN

Configuration |

The following network components are installed:

adapters, or only the Dial-up adapters at Netwark of Xircom Ethernet+Modern (CEM28.8) :_l
installation. 1f you are using a Dial-up connection & P Protocal -» DialUp Adapter

to the Internet, you will only need the Dial-up Fwi1 Protocal -» Metwork of Kircom Ethernet+adem [EEIJ
Adapter configured for SecuRemote. If you work TCPAP -» Pt [DialJp Adapter]

at your officeon aLocal AreaNetwork (LAN), and TCPAP -» Pl Metwork of Kircom Ethernet+adem [CEl
use SecuRemote to access other remote sites, then 4| | b
you will need to install it on Both the Dial-up

adapter and the LAN Adapter.

These settings can be found under the Control Panels> Network. The Diagram shown Aboveis after
SecuRemote I nstallation.

If installed on both Dial-Up Adaptersand LAN Adapters, SecuRemote will modify the original settings

FROM TO
TCP/ 1P > Dial-Up Adapter TCP/IP > FWL(Di al -Up Adapter)
FWL. Protocol -> Dial-Up Adapter

TCP/ 1 P > LAN Adapter TCP/IP > FWL (LAN Adapter)
FWL. Protocol > LAN Adapter

SecuRemoteinsertsa”“ SHIM” between the Adapter Layer and the TCP/IP Layer of the Operating
System. No TCP/IP Communication can occur unlessit passes through the SecuRemote Layer. Thisis
whereit will be decided to encrypt the packet, or not to encrypt the packet before forwarding it.

After installing the SecuRemote software, you must reboot your PC for the Driversto take effect.

Now that the SecuRemote Software has been loaded on the PC, now we must configureit.

1



Step 3.  Configure the SecuRemote Software by double

|

clicking on the envelope

hand corner of the screen.

, in the bottom right

e =8 TICEEAE]
Sl DO 11:484M

2 Sites - FireWall-1 SecuRemote 8] K3 Thiswill bring up the Screen shown at the left.
File Wiew Sites Pazswords Help .
= Now Select Site > MakeNew
97w
iy Sites - Firewall-1 SecuRemote
ikl Fazzwods  Help
B Make Mew...
M [efete
For Help, press F1 Itz Broperties

The Screen Below will now be displayed

Make new zite

I

Now, enter the |P Address, or a Name that can be resolved to an |P Address. In our case, this must be the
IP Address of the External Interface of the Firewall, because it isthe Certificate Authority for the Firewall.

- 192.32.42.31 was entered, and click “ OK”

Site
 Site Identification—————————

|1 gz32. 423

tame:

~Internal Drata

IP Address: |192.32.42.31

Ky ID: |d1 £3041a1ed09be3de] 8257
Ky ID Date: IMon bdar 10 16:52:13 1337
Last Update IWecht221?:28:DE1SB?

Cancel |

B Firewall-1 SecuRemote I

& The P &ddress and the kKey [D should be verified!

NOTE:

Y ou should now see communications from the
SecuRemote client to the Firewall, and the Grayed
portion of the screen labeled “Internal Data” will be
filledin Automatically.

NOTE: If you ever change the “encrypted Domain
Information on the Firewall, you must
“UPDATE" thissite so that SecuRemote
knows to encrypted the data to the new
Encryption Domain Locations. Thisis
done by Double Clicking on the Site and
Selecting the“UPDATE” Button.

If you are successful, the next screen will show up,

specifying that the IP Address and Key 1D should
be verified with the Firewall Administrator. Thisis
to validate that the Key information is actually
from the Firewall itself, and no-one spoofed this
data. Thisisalso agood way to verify if the
SecuRemote user has the latest Encryption
Domain Information. This can be obtained by
looking at the Last Updated Date.

If you are not successful, try and PING the IP address of the Firewall to make sure you can

communicate with this site. Communications to the Firewall will be needed before trying to “Make
aNew Site” in SecuRemote. For Dia-up Adapter users, make sure you have avalid Internet
Connection before trying to make anew sitein SecuRemote. Y ou might also want to ping another
siteaswell (www.yahoo.com for example) to seeif your Internet connectionsis properly
configured. If you can't ping the IP Address of the Firewall, you must fix this communications

problem before you continue.




*kkkkk NOTE *kkk*k

If you Receive the Error Message below, make sure the firewall has the proper license for a“ CA” by typing

in thefollowing:

From Unix: From Windows NT:
letc/fwi/bin/fw printlic \winnt\fwAbin\fw printlic 4— Gl Qigt Proes
FireWall-1 SecuRemote
«— Manegamat Save Rocey
o Enror: Site 192.32 4231 says that it is not a Certificate Autharity.

Check whether you have got the right |P-address for 192 32 4231,

and check with the Faé-1 spstem manager there whether 132324237 is indeed i e— Firenell Modlle Rocess

a FW-1 control station

Inour corfiguraion, dl threeprocesses
resceanthesamephyscd medine

If you have avalid license, make sure the Certificate Authority (CA) is not De-coupled from the Firewall
Module machine, and placed on the Management Server machine (ie. Control Station). If thisisthe case,
you must type in the address of the Management Server Machine in the SecuRemote Window for Making a

New Site, and not the Firewall’ s IP Address

¥PH-1 SecuRemote

Q Error: The site iz not licensged to perfarm the requested action.

If you receive this error message on the left, please
get a"SecuRemote” license. SecuRemote hasto be
licensed in order to get the topology download and
the site definition. Y ou can contact your reseller or
Check Point Representative for this"free" license.
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Now you Should be ready to test the SecuRemote Encryption. Simply use your normal application to
connect to the Mail Server, and the following window will pop-up. Thisiswhere you enter your User Name
and Password as defined by in Firewall. Inmy case, | typedin “joe” with apassword of “Xxxxx”.

FireWall-1 SecuRemote: Password ]
|1 92324231 %

Site:
User: I OF. I
Pagzsword: I ﬂl

i Sites - Firewall-1 Secu... [lj=] E3

Eile

il T

Wiew Sites Pazsword:  Help

:.\II“_l'_

For Help, press F1

il Sites - Firewall-1 SecuRemote

=] E3

File “iew Sitez Paszwordz

) el [ e

Help

=
=
[ INC

Exchanging keys with a Firgha/all.

Y ou might also want to position the SecuRemote Screen so
as to see the bottom section (where it saysFor Help, Press
F1). Thisshould now change to the “ Exchanging K eyswith
aFirewall”, after you hit the “OK” button for the User and
Password box on the | eft.

If you were using SecuRemote in addition to checking your email, it might look like the following diagram(s)

on the next page.....

Step 1. Check Mail

& Eudora Light 100 x]

Edit Malboy Message Transfer Specill Took Window Help EudoraPro
L]

[

Lilyed

Save
Gave s,
|
¥

Send ueuedilessages: Ll
Chrst

i,
Print Presien
| Pint Selup.

Eut L]

i1 Sites - FireWall-1 Secu... [ B3
File ew Sies Passwords Help

o]
W

2 Connected to ATAT Joe (] %]
Cannected at 7600 bps -
B Dulion 0001104 i

Step 2. SecuRemote Pops Up

!-I? B30 i Rl T T D = ﬂl
— i £ Miim Mo (e Gd [ nm o Eciifn

| 2ieiel¢)al o vl

iy

+ Far Help, press F1

Detale |
GEHEAT

LGS §
Step 3. Enter Username and Password

oy | ]

ek

| Bl | Wooed | s | - Gron | s |

'j{-.{'.w" o -ﬂ-zm'

Step 4. SecuRemote Exchanges Key with Firewall
and establishes Encrypted Link to Firewall.
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Step 5. User is Authenticated at the firewall, and

Eudora Session is connected to the Mail
Server retrieving their mail over an encrypted
link over the Internet.

This Processistransparent to any application, because
SecuRemote isa Shim in between Layers 2 (Data Link)
and Layer 3 (Network). Y ou can use other applications
such as Telnet and FTP to test your particular
situation.

Tunnding With SecuRemote

Given the Diagram on the | eft, we will now use
SecuRemote to “encapsulate” from the client
(199.32.42.30) to the firewall (192.32.42.31), and
then route to the Illegal 1P Address of the
Server (10.10.1.20). Wewill use Telnet on the
client to access the Mail Server for
administrative purposes.

Thefollowing additional Firewall
configurations must now be added:

1. Addthefollowing Objectsto the Firewall:
Mail Server (10.10.1.20)
Net10 (10.10.1.0/255.255.255.0)
Group “encrypt-zone” with Net10
2. Add Net10 to the Encryption Domain on
the Firewall (to encrypt to Mail Server)

3. Select “Encapsulation” in the Encryption

Tab onthe Firewall Object “firew”.
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Configuration Steps

1. Createthe Mail Server Object (10.10.1.20)

Workstation Properties

SHMP | E ncryption I

Address Translation I
General | Interfaces I

Authentication

Hame: Imail-ser\-'er

Get address |

IP Address; [10.10.1.20]

LComment; ;

Locatian:
’7(:' Intermal = External

’7(3' Host ) Gateway !

o |

Color: | NI ~

™| Eirewfall-1 installed
™ Ezportable

Cancel | Help I

2. Create the Network object 10.10.1.0 Network

Metwork Properties

General | Address Translationl

Marne: I

P &ddress: I‘I n10.1.0

Get address I

Met Mask: |255.255.255.0

LComment: i

Color: i | ] :J
Location: —— Broadcast: i
’75' Internal = Extemnal ’75' Allowed  Disallowed |

[ ox ]

Cancel | Help

Mares |mncaph-2ore

Gomemerd |
Cake | I -

ok i Gioag In Broas
B o {m net10
] wree

& pantact
B e
.!H mad-zarar
By netz
| 3 ek

oK. Carod Hep

Create a Group Object “encrypt-zone” with “net10”
asamember of thisgroup. Thiswill allow the
firewall to encry pt/decrypt anything to this network
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Workstation Properties . .
1. Add“Encrypt-Net” to the Encryption Domain

General | Interfaces | Authentication | on the Firewall Object “firew” as shown to the
SNMP Encption | Address Translation left.
- Encryption Domain; - Enciyption Methods Defined; —
" Disabled 2. Select “Use Encapsulation” as shown to the
" Yalid Addiesses |eft.
& Other:
i @ encrypt-zong vl 3 Click “OK”
Edi... |
[¥ Use Encapsulation

4.  Now Download the Security Policy to the
Firewall at this point.

oK I Cancel | Help | Policy > Install

On SecuRemote M achine.

&% Sites - FireWall-1 5. [H[=] E3
File “iew Sitez Passwords
Help

1. Now DoubleClick on the“192.32.42.31" |con to update the
site. We need to update the site to tell the SecuRemote Client
that there is new encryption domain information
(10.10.1.0/255.255.255.0), and to encapsul ate the traffic.

2. Next, Update the site by clicking on the “Update’ button.

192324231

Site

— Site Identification

|Jpdate
For Help, press F1 4 Name 192324231 |

~Internal D ata

Now we can try and Telnet to the 10.10.1.20 Mail IP Address: |192.3242.31
Server from the SecuRemote Client.

Kyl |d15304Taedl5bedde182257

You will seethe “Snoop” traces and Log Viewer of KeyID Diate: JMon Mar 101652131357
the results on the next page.

Last Update ITueDcl281?:55:13199?

17



The Log-Viewer on the Firewall Showsthe Telnet Session from the user “joe” located on the “joe-pc”
(199.32.42.30) machine going to the destination of the Mail Server (10.10.1.20).

E fw.log - Firewall-1 Log Viewer
File Edit “iew Select “Window Help
=8| gkl 2l 2wl =@ [8 [ M
= |Date |Time |0ri.. |Type |A|:1iun |Service |Suurce |Destinati.. |Pmtu. |Flu|e |S_Puﬂ |User ;l
0 290ct.. 1550:23  firew F‘: cortrol ctl
1 290ct.. 1550028 firew E [Lal] E dectypt  telnet-23 joe-pc mail-zerver top 1 1153 joe

== |
<I I _>I’J
For Help, press F1 [logview.f  [192.32.42 31 Pk 4

By Scrolling over in the Log Viewer, notice the Encryption Method in the Info Field. (DES, DES, None)
Thiswill help you identify the machines and the encryption types.

E fw.log - FireWall-1 Log Yiewer =] B3
File Edit “iew Select “Window Help

DeE| Skl gz 27| #|& B [l -

|Source |Destinati.. |Prutn. |Flu|e |S_Pon |User |SrcKeyID |Infu. -l

started sending log to localhost
joe-pc misil-zerver top 1 1153 joe 21719a214d0c  zcheme: AT methods: DES DES MOME
(ol

Kl | _'IJ
For Help, press F1 [logview fw  [192.32.42 31 rLIM i

By using the “ Snoop” command on the Solaris Firewall, we can look at the Packet Traces from the two
Interfaces.

External Interface (192.32.42.31) Interna Interface (10.10.1.1)
firew# snoop-d 1e0 trek# snoop-d lel
Using device/dev/le (promiscuous mode) Using device /dev/le (promiscuous mode)
199.32.42.30 -> firew IP D=192.32.42.31 S=199.32.42.30 LEN=810, 199.32.42.30 -> mail-srv  TELNET C port=1169
I1D=46616 mail-srv -> 199.32.42.30 TELNET R port=1169
firew->199.32.42.30 IP D=199.32.42.30 S=192.32.42.31 LEN=366, 199.32.42.30 -> mail-srv  TELNET C port=1169
1D=49409 199.32.42.30 -> mail-srv - TELNET C port=1169
firew->199.32.42.30 IP D=199.32.42.30 S=192.32.42.31 LEN=121, mail-srv ->199.32.42.30 TELNET R port=1169
1D=49410 199.32.42.30 -> mail-srv - TELNET C port=1169
199.32.42.30 -> firew IP D=192.32.42.31 S=199.32.42.30 LEN=49,
1D=46360
199.32.42.30 -> firew IP D=192.32.42.31 S=199.32.42.30 LEN=121,
1D=46872 199.32.42.30 -> mail-srv - TELNET C port=1169
firew->199.32.42.30 IP D=199.32.42.30 S=192.32.42.31 LEN=49, ID=893 199.32.42.30 -> mail-srv  TELNET C port=1169
mail-srv -> 199.32.42.30 TELNET R port=1169
mail-srv ->199.32.42.30 TELNET R port=1169
firew#
199.32.42.30 -> firew IP D=192.32.42.31 S=199.32.42.30 LEN=45,
1D=47128
firew->199.32.42.30 IP D=199.32.42.30 S=192.32.42.31 LEN=60, ID=894
199.32.42.30 ->firew  |P D=192.32.42.31 $=199.32.42.30 LEN=48, The Snoop trace on the External Interface
1D=47384 shows the “ Encapsul ated” Packet from the
firew-> 199.32.42.30 |P D=199.32.42.30 $=192.32.42.31 LEN=45, |D=895 . .
firew# SecuRemote Client. The Address of “firew”

i5192.32.42.31. The Column on the Right
shows the packet after it has been decrypted,
and un-encapsul ated and routed to the Mail Server. Notice that you can identify the “ Telnet” application
within the packet trace after it has been decrypted by the firewall. This packet is using the Telnet Port which
isport 23.
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The details of one of the encapsulated packets are shown below. Please notice that this packet isusing IP
Protocol “94” to encapsul ate the original packet into thisformat.

firew# snoop -d 1€0 -v

Using device /dev/le (promiscuous mode)
ETHER: ----- Ether Header -----
ETHER:
ETHER:
ETHER:
ETHER:

Packet 1 arrived at 16:06:54.03
Packet size = 849 bytes
Destination = 8:0:20:7b:d2:45, Sun

ETHER: Source = 0:80:c7:73:fe:8d, Xircom Inc.
ETHER: Ethertype = 0800 (IP)

ETHER:

1P - |P Header -----

IP:

IP: Version=4
IP:  Header length = 20 bytes
IP: Type of service = 0x00

IP: XXX. .... = 0 (precedence)
1P ...0 .... =normal delay

IP: .... 0... = normal throughput
IP: ... .0.. = normal reliability

IP: Total length = 835 bytes
IP: Identification = 41752

IP: Flags = 0x0
IP: .0.. .... = may fragment
IP: ..0. ... = last fragment

IP:  Fragment offset = 0 bytes

IP: Timeto live = 32 seconds/hops

IP: Protocol =94 ()

IP; Header checksum = 1fc3

IP;  Source address = 199.32.42.30, 199.32.42.30
IP:  Destination address = 192.32.42.31, firew
IP: No options

IP:

<xx*xx%x |P Protocol 94 is used for SecuRemote Encapsulation ***** >

Troubleshooting: if you can’t connect to the Mail Server:
1. Validatethat thereis|P Connectivity between your SecuRemote Client and the Firewall

If you are having trouble connecting to the firewall, try
“Killing” SecuRemote by clicking File > Kill. Thiswill

&% Sites - FireWall-1 Secu... M=l E3

AN “iew Sites Password:  Help

disable SecuRemote, so that you can validate the machine can
actually PING the firewall for connectivity. Then SecuRemote
can bereinstalled by clicking Start > Programs - Firewall-1
- SecuRemote

If you have been able to Define the site and retrieve the keys,
thiswill eliminate the lack of IP Connectivity Issue, and there
is another problem.

2. If the SecuRemote Client, does not pop-up when you try and connect to the Mail Server, Validate the
Encryption Domain on the Firewall. Thiswill tell the SecuRemote Client when to start the
Authentication process for the Encrypted Destinations.

3. If the Encryption Domain looks OK, make sure the SecuRemote Client has “ Updated” its information.

Thereisaso afile on the SecuRemote PC named “userc.c” that will show the encryption domain.

Check out the Log Viewer, and seeif there is any connectivity from the SecuRemote client.

Make sure the Firewall can communicate to the mail server

6. Validate the Security Policy to make sure that communicationsis allowed to/from the proper devices.
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7.  Runthe“Snoop” trace to see the packets to and from the SecuRemote Client. On Windows NT, use the
Monitor Application.



